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About TIBCO iProcess® Script Plug-in

TIBCO iProcess Script plug-ins enable the creation of server-side script steps that generally
provide integration with some external system or local server-side processing capabilities.

The following are the two components that make up the functionality:

« IProcess Script Client Plug-in - This component is the design-time component that
integrates into iProcess Modeler and provides the user interface for the iProcess
Developer to build the step. The client plug-in can call through to the server (run-
time) plug-in at design-time to gain access to information to improve the
development experience.

 IProcess Script Server Plug-in - This component is the run-time component that
actually has the capability to execute the step and perform the operation or call the
external system. The server plug-in provides the ability for an iProcess Developer to
insert an iProcess Script inline in the process, it is called between the execution of
other steps as part of the server-side transaction. It is used to manipulate data
internally in iProcess, that is, to set, validate, or manipulate iProcess fields.

The client plug-in is automatically installed as part of iProcess Workspace (Windows), and
the server plug-in is automatically installed as part of iProcess Engine.
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About Script Editor

The main functionality of TIBCO iProcess™ Script Client Plug-in is to write or edit an EAI

script. The script editor of the client plug-in has an easy-to use and productive interface
that allows you to write or edit code quickly and efficiently.

e Menu bar and Toolbar: The Menu bar and Toolbar facilitate the use of key features
that have been added. Common actions that you can perform are provided on the
toolbar. Click on the toolbar icon to select the action.

File Edit Wiew Help -

oo ‘2 ErI'_'-1 =] | 9' Toolbar

I

Check Script

Menu bar

Paste

Copy

Cut

o Status Bar: The Status Bar has five sections. The first section shows the file size, and
the other three sections show CAP lock, NUM lock, and SCRL lock. The Status Bar
also shows the number of errors in red when a syntax check is run on the script.

Scroll Lock | =
Mum Lock
Mumber of errars in script Caps Lock
' File size

Script contains 1 error 165 CAP |NUM [S5CF
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Script Editor Features

From version 11.9.0, the script editor has significantly enhanced functionality. The script
editor provides key features that you can make use as follows:

e Using Color-Coded Keywords

Using Bookmarks

« Inserting New Fields Using Intellisense

Expanding and Collapsing Code Blocks

Viewing Line Numbers

o Checking the Script

1 By SETUP - init: EAl Script Definition - O X

| File Edit View Help

Joe;_'lm|§|e|

1

TEXT :="scripts test” l Bookmark l =

NUMERIC :=5 L b
CSNUMERIC:=1 Ine numper

3
4
5 DATE
5 )
8

;'Tlf!w_é_'—_. Colored-coded kevwordsl
= rail
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SW_CASEDESC := "Check test script”

T : :
10 ENDIF
11 i Nested code

% [CONFlG | A
CSNUMERIC

DATE

MODE

NUMERIC ——-l New field insertion l
RESULT

RETRY

SCRIPT

SW_CASEDESC

SW_CASENUM v

& o D P9 e

l Icon that shows an error l

Message that shows the number of errors l l File size - number of characters
—

ali— ¢ I B |

Script contains 1 error 165 @Wlﬁ A
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Using Color-Coded Keywords

Color-coded keywords differentiate strings, comments and so on, and it displays them in
different colors.

The following table lists the Script keywords and their respective colors.

Color Is Case Sensitive? Keyword

Blue False Script statements

Dark blue False Script supported functions, Boolean values
Dark gray NA Single and multiline comments

Dark green NA A String literal

Magenta False iProcess Fields

Green NA Date

Dark Magenta NA Time (enclosed between ##)

Black NA Array indexes

Red False iProcess functions that are not supported

Using Bookmarks

Bookmarks help you to mark a point and quickly jump to that point, as well as back and
forth between such points in your script. When you add a bookmark, the bookmark icon is
visible in the left before a line number. You can add bookmarks, move from one
bookmark to another and clear bookmarks in the following way:

o To add a bookmark, select the menu option Edit > Toggle Bookmark or use the
keyboard shortcut Ctrl+F2.

o To move to the next bookmark, select the menu option Edit > Next Bookmark or
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use the keyboard shortcut F2.

o To move to the previous bookmark, select the menu option Edit > Previous
Bookmark or use the keyboard shortcut Shift+F2.

e To clear or remove a specific bookmark, select the menu option Edit > Toggle
Bookmark or use the keyboard shortcut Ctrl+F2.

o To clear all bookmarks, select the menu option Edit > Clear All Bookmarks.

Inserting New Fields Using Intellisense

Intellisense assists you to edit or complete your code by providing the required fields or
parameters that you can insert in a given context. When you hover over a function, it
provides a list with details of the function making it easy for you to complete the script
expressions with the correct details.

To insert iProcess case fields and add expressions in your script, use the keyboard
shortcut Ctrl+Shift+L.

Expanding and Collapsing Code Blocks

Nested code blocks can be expanded or collapsed. You can expand a code block if you are
doing a detailed check or collapse a code block if you are skimming over it while checking
your script.

To expand a code block, click the plus symbol (+) beside a nested code block; and, to
collapse a code block, click the minus synbol (-) beside the nested code block.

Viewing Line Numbers

Line numbers are provided at the start of a line. You can view or hide line numbers as
required.

To view or hide the line numbers, use the menu option View > Line Numbers.
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Checking the Script

Script checking is now available. You can perform an auto-check or manual (on-demand)
check of the script. You can search by using Ctrl+F to find the specific content. The
following sections explain these checks.

Auto-Checking

When auto-check is selected, it validates the script and marks the errors with a warning
icon every time the user stops typing. It is a good practice to select this option as the
preferred default option because when a user is creating or editing a script, immediate
feedback is provided if there is an error. However, if auto-check is interfering with the
editing process or with the product performance (that is, when the script is very large, say
more than 12,000 lines of code), you can disable auto-check for some time and enable it
again later.

To set auto-check, use the menu option Edit > Auto-Check Script or the keyboard option
Ctrl+U.

Manual (On-demand) Checking

When manual check is selected, it validates the script and marks the errors with a warning
icon. However, when you fix any error it only rechecks the specific lines marked with the
warning icon. If you make changes in any other lines of the script, the editor does not
check these lines for new errors.

To set manual check, use the menu option Edit > Check Script or the keyboard option
Ctrl+S.

The number of errors in the script are indicated in the status bar at the bottom of the
window. For an example, see About Script Editor.
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Creating Script Plug-in Steps

This section describes how to define Script Plug-in steps in your iProcess procedures.
Script Plug-in steps enable you to manipulate case data between other iProcess steps. For
example, you might want to perform some calculations on some case data before sending
the result to your next step.

Example Uses of Script Plug-in Steps

The following examples describe typical uses for an Script Plug-in step (or EAI step) to
manipulate case data.

» Concatenating Data

« Performing Calculations

Concatenating Data

You can use an EAIl step to extract the date and time from an external application. You will
then have two iProcess fields such as DATE and TIME containing these values. You can
create an EAI step to concatenate the two fields to create just one TIMEDATE field. For
example, enter the following script:

TIMEDATE:=TIME+DATE

You might need to do this before using an EAI Database plug-in to insert the time and date
into your database.

Performing Calculations

You can perform background calculations such as calculating the interest owed on an
account balance that has been extracted from a banking database. The new balance
amount can then be passed to another external system.
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The iProcess scripting language is used to create the scripts. Please refer to the Example
Uses of Script Plug-in Steps for detailed information about using expressions and
functions in your scripts.

Note: Currently, not all of the iProcess expressions are supported in the
iProcess Script plug-in. For a current list of unsupported expressions, see
iProcess Expressions Not Available to the iProcess EAI Script Plug-in.

What is the Transaction Scope of Script Plug-in
Steps?

Any changes made to iProcess case data by your script are committed or rolled back with
the entire workflow transaction. If a subsequent Script Plug-in step (or EAI step) fails then
changes made by your Script Plug-in are rolled back.

If an invalid expression is found by the Script server/run-time plug-in (i.e. syntax errors),
the Script Plug-in step will stop immediately and iProcess is notified that the transaction
should not be committed. The error(s) will be logged in the SWDIR\logs\sw_warn file - see
Tracing Problems in Your Scripts for more information.

iIProcess Expressions Not Available to the
iProcess EAI Script Plug-in

The following iProcess Expressions are currently not available to the iProcess Script Plug-
in. Therefore, even though you can successfully enter the expressions in your iProcess
Script plug-in definition, they are not processed by iProcess Engine. All of the following
expressions return SW_NA (except GOTOSTEP, which has its own error code).

o CASESTART

o DBWRITEFIELDS, DDEGETNAME, DDEGETTOPIC, DDEINITIATE, DDEPOKE,
DDETERMALL, DDETERMINATE, DDEEXECUTE, DDEREQUEST

o FILEREQUEST, FORMCONTROL, FORMMAXIMIZE, FORMMINIMIZE, FORMMOVE,
FORMRESTORE, FORMSIZE
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o GETHANDLE, GOTOSTEP

» MARKFIELDCHANGED, MEMOFILE, MESSAGEBOX
o READFIELDS

o SENDKEYS, SERVEREXEC, SERVERRUN

o TRIGGEREVENT

o UNIXEXEC, UNIXRUN

o VLDFILE, VLDFILEX, VLDQUERY

o WINACTION, WINACTIVATE, WINCLOSE, WINEXIST, WINFIND, WINMAXIMIZE,
WINMESSAGE, WINMINIMIZE, WINMOVE, WINRESTORE, WINRUN, WINSIZE,
WRITEFIELDS

Prerequisites for Using Script Plug-in Steps

Before using Script Plug-in steps in your business process, you need to make sure you
meet the following prerequisites:

« The client (design-time) and server (run-time) iProcess Script Plug-in components
must be installed.

o Note: If you are just running EAIl steps on your server, you only need to install
the run-time plug-in. You only need the design-time plug-in if you are creating
EAIl steps.

« You need to be familiar with using the iProcess scripting language. For more
information, see TIBCO iProcess Expressions and Functions Reference Guide.

* You must know which iProcess Expressions are not available to the iProcess Script
Plug-in, see iProcess Expressions Not Available to the iProcess EAI Script Plug-in.

Creating an EAI Script Plug-in Step

To create a Script Plug-in step in your procedure, you must perform the following steps:

1. Define Basic EAI Step Information
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2. Define the EAI Script

When you have done this, the EAIl step type is defined as a EAI Script step and the icon for
the step is displayed as .

Define Basic EAI Step Information

1. Start the TIBCO iProcess Modeler, click the EAl Step tool “®| and click in the window
where you want to place the EAI Step.

2. In the Properties pane, enter the Name and Description for the step.

3. In the EAI Type drop-down list, select EAISCRIPT - EAI SCRIPT EAI step plug-in.

You must enter this when you first create the step; it cannot be changed later. The
list box displays EAI step types that have been installed as client EAl plug-ins. This

name is used as the link between the EAl step and the run-time plug-in registered

on the iProcess server(s).

4. Click the Ignore Case Suspend check box if you want the step to still be processed
as normal while a case is suspended by an iProcess Objects or SAL application.

If Ignore Case Suspend is not checked (the default option), the step is not processed
while the case is suspended.

o Note: Cases can only be suspended and re-activated from an iProcess Objects
or SAL application. Audit trail messages indicate whether a case is active or
suspended. For more information about suspending cases, see the iProcess
Objects documentation.

5. Click the Audit Trail tab to define custom audit trail entry expressions. This enables
you to define text expressions that are evaluated when the step is processed and
inserted as the %USER value in the audit trail entries.

Definition | Audit Trail | Delayed Release | Deadlines | Duration | Options |

Custom text expressions to insert in audt entries Apply
Call-Out Initiated: [ SWADMIN Revert

_Revet|
Help |

You must enter a value in both fields or leave them both empty:
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— In the Call-out Initiated field, enter a valid text expression that replaces the
%USER value in the audit trail when the call out is initiated.

— In the Call-out Complete field, enter a valid text expression that replaces the
%USER value in the audit trail when the call out is complete.

Note: Delayed release and Deadlines are not applicable to the EAIScript step so
the Delayed Release and Deadlines tabs are grayed out for the EAIScript step.

6. Click the Definition tab, then click Edit. The EAI Script Definition Define the EAI
Script dialog box is displayed. You can define your script in this dialog box.

Define the EAI Script

1. In the Properties pane, click Edit. The EAI Script Definition dialog box opens and
the script editor enables you to define the iProcess script that you want to run
when the EAIl step is processed (as shown in the example below).

,;% SETUP - init: EA| Script Definttion - 0 X

File Edit View Help

REEN)
1
2 TEXT :="scrpts test”

31 NUMERC =5

4 ¢ CSNUMERIC =1

B 5 DATE:0072020]

61 TME-

71 TRES="Fl"
8

i i

Ready 105 |CAP |NUM |SCF

The scripting language is the same that is used when creating scripts in other
iProcess steps using the Script Editor. Define your script using one expression per
line. It can contain blank lines and comment lines starting with a semi-colon (;).
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Refer to Define the EAI Script for information about the expressions and functions
you can use. For detailed information about creating a script, see Define the EAI
Script.

2. Use Ctrl+Shift+L to insert iProcess case fields and add expressions in your script.
When you press Ctrl+Shift+L, a list box with the iProcess case fields is displayed (as
shown below).

,;E:, SETUP - init: EAI Script Definttion - 0o X
File Edit View Help
s2BE 0
1 -
20 TEXT:="scritstest” I |
3 NUMERLC =5
CSNUMERIC =1
5 DATE :=105/07/20?
£ TIME=
7 TRES ="Hl"
8 .
4§ |CONFIG A
§ CSNUMERIC
% DATE
§ MODE
§ NUMERIC
§ RESULT
§ RETRY
§ SCRIFT
§ SW_CASEDESC
) SW_CASENUM v
<] ﬂJ
Copy the selection and put it on the Clipboard 104 [CAP [NUMSCR

You can select a field, and the field is inserted in the script editor.

3. Set your default option as auto-check, and check for any error in your script. For
details, see Checking the Script. You can correct the errors in the script or ignore all
errors. If you choose to ignore the errors, the step is marked as incomplete until

the errors are corrected.

4. Click Save to save your script.

Tracing Problems in Your Scripts

To log the processing of EAI script steps by the run-time plug-in, you can set debugging on
your background servers so that the processing is logged to a file. To set trace logging on,
enter the following command on your TIBCO iProcess Engine:
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swadm set_attribute 1 BG © DEBUG x=32

This causes EAI script trace level log messages to be output to text files in the SWDIR\logs
directory on the machine hosting the TIBCO iProcess Engine (called bgn.log) where n is the
number of the BG process.

Error Logging

When iProcess processes the EAl Script step, any errors encountered are logged in one of
two ways:

e In the SWDIR\logs\sw_warn file - see Error Messages in the SWDIR\logs\sw_warn File

« Or via an audit trail entry for the case. This happens only if the case was started in
a previous transaction so that there is a case to add an audit entry for. The EAI
Script step will be retried by iProcess according to the number of retry settings
configured for the TIBCO iProcess Engine.

Error Messages in the SWDIR\logs\sw_warn File

The following is a list of the possible EAI Script step error messages that can appear in the
SWDIR\logs\sw_warn file.

Incorrectly defined WHILE/IF construct (or too many nested IF's).
Description

The script has been incorrectly constructed.

Action

Correct the WHILE/IF construct or remove the surplus IF statements. Use Trace logging to
help you find the problem especially if it is a large script -see Tracing Problems in Your
Scripts.
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Invalid or non-boolean expression '<text from script line in question>' in
WHILE statement.

Description

The invalid expression errors are not common in the sw_warn file because the script is
syntax checked when you are defining it. However, the following can cause these errors to
be logged:

» Deletion of a procedure field used in the expression (after the script was last
edited).

« Use of an expression that is valid in the version of the TIBCO iProcess Modeler that
the procedure was defined on but is not valid on the server that the expression is
run on.

Action

Edit the script definition and check the script using the Check Script button. Or, you can
use the keyboard shortcut Ctrl+U (for auto-check) or Ctrl+S (for manual check). Correct
any errors that are reported.

The following are similar error messages that can be logged in the sw_warn file. These
can be corrected by editing the EAI Script step and using the Check Script button to find
any errors.

Invalid or non-boolean expression '<text from script line in question>' in
IF statement

See the description of the previous message.

Invalid or non-boolean expression '<text from script line in question>' in
ELSEIF statement

See the description of the previous message.

Error processing command expression '<text from script line in question>'

See the description of the previous message.
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TIBCO Documentation and Support Services

For information about this product, you can read the documentation, contact TIBCO
Support, and join TIBCO Community.

How to Access TIBCO Documentation

Documentation for TIBCO products is available on the TIBCO Product Documentation
website, mainly in HTML and PDF formats.

The TIBCO Product Documentation website is updated frequently and is more current
than any other documentation included with the product.

Product-Specific Documentation

The following documentation for this product is available on the TIBCO iProcess®
Workspace (Windows) Product Documentation page:

e TIBCO iProcess® Workspace (Windows) Release Notes

Read the release notes for a list of new and changed features. This document also
contains lists of known issues and closed issues for this release.

e TIBCO iProcess® Workspace (Windows) Installation

Read this manual for instructions on site preparation and installation.

e TIBCO iProcess Suite Documentation Library

This library contains all the manuals for TIBCO iProcessWorkspace (Windows), TIBCO
iProcess® Modeler, and other TIBCO products in TIBCO iProcess Suite. The manuals
for TIBCO iProcess® Script Plug-in and TIBCO iProcess® Modeler are the following:

» TIBCO iProcess Workspace (Windows) User Guide
e TIBCO iProcess Modeler Getting Started

« TIBCO iProcess Modeler Procedure Management
« TIBCO iProcess Modeler Basic Design

e TIBCO iProcess Modeler Advanced Design
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« TIBCO iProcess Modeler Integration Techniques

« TIBCO iProcess Expressions and Functions Reference Guide
« TIBCO iProcess Workspace (Windows) Manager’s Guide

e TIBCO iProcess COM Plug-in User Guide

e TIBCO iProcess Database Plug-in User Guide

e TIBCO iProcess Email Plug-in User Guide

« TIBCO iProcess Script Plug-in User Guide

« TIBCO iProcess Plug-in SDK User Guide

Other TIBCO Product Documentation

When working with TIBCO iProcess® Script Plug-in, you may find it useful to read the
documentation of the following TIBCO products:

e TIBCO ActiveMatrix BusinessWorks™

e TIBCO Business Studio™

TIBCO Enterprise Message Service™

TIBCO Hawk®

e TIBCO Rendezvous®

How to Contact TIBCO Support

Get an overview of TIBCO Support. You can contact TIBCO Support in the following ways:

o For accessing the Support Knowledge Base and getting personalized content about
products you are interested in, visit the TIBCO Support website.

o For creating a Support case, you must have a valid maintenance or support contract
with TIBCO. You also need a user name and password to log in to TIBCO Support
website. If you do not have a user name, you can request one by clicking Register
on the website.

How to Join TIBCO Community

TIBCO Community is the official channel for TIBCO customers, partners, and employee
subject matter experts to share and access their collective experience. TIBCO Community
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offers access to Q&A forums, product wikis, and best practices. It also offers access to
extensions, adapters, solution accelerators, and tools that extend and enable customers to
gain full value from TIBCO products. In addition, users can submit and vote on feature
requests from within the TIBCO Ideas Portal. For a free registration, go to

TIBCO Community.
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Legal and Third-Party Notices

SOME TIBCO SOFTWARE EMBEDS OR BUNDLES OTHER TIBCO SOFTWARE. USE OF SUCH EMBEDDED
OR BUNDLED TIBCO SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY (OR PROVIDE LIMITED
ADD-ON FUNCTIONALITY) OF THE LICENSED TIBCO SOFTWARE. THE EMBEDDED OR BUNDLED
SOFTWARE IS NOT LICENSED TO BE USED OR ACCESSED BY ANY OTHER TIBCO SOFTWARE OR FOR
ANY OTHER PURPOSE.

USE OF TIBCO SOFTWARE AND THIS DOCUMENT IS SUBJECT TO THE TERMS AND CONDITIONS OF A
LICENSE AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED SOFTWARE LICENSE
AGREEMENT, OR, IF THERE IS NO SUCH SEPARATE AGREEMENT, THE CLICKWRAP END USER
LICENSE AGREEMENT WHICH IS DISPLAYED DURING DOWNLOAD OR INSTALLATION OF THE
SOFTWARE (AND WHICH IS DUPLICATED IN THE LICENSE FILE) OR IF THERE IS NO SUCH SOFTWARE
LICENSE AGREEMENT OR CLICKWRAP END USER LICENSE AGREEMENT, THE LICENSE(S) LOCATED IN
THE “LICENSE” FILE(S) OF THE SOFTWARE. USE OF THIS DOCUMENT IS SUBJECT TO THOSE TERMS
AND CONDITIONS, AND YOUR USE HEREOF SHALL CONSTITUTE ACCEPTANCE OF AND AN
AGREEMENT TO BE BOUND BY THE SAME.

This document is subject to U.S. and international copyright laws and treaties. No part of this
document may be reproduced in any form without the written authorization of TIBCO Software Inc.

TIBCO, the TIBCO logo, the TIBCO O logo, ActiveMatrix BusinessWorks, TIBCO Business Studio,
Enterprise Message Service, Hawk, iProcess, and Rendezvous are either registered trademarks or
trademarks of TIBCO Software Inc. in the United States and/or other countries.

Java and all Java based trademarks and logos are trademarks or registered trademarks of Oracle
and/or its affiliates.

This document includes fonts that are licensed under the SIL Open Font License, Version 1.1, which
is available at: https://scripts.sil.org/OFL

Copyright (c) Paul D. Hunt, with Reserved Font Name Source Sans Pro and Source Code Pro.

All other product and company names and marks mentioned in this document are the property of
their respective owners and are mentioned for identification purposes only.

This software may be available on multiple operating systems. However, not all operating system
platforms for a specific software version are released at the same time. See the readme file for the
availability of this software version on a specific operating system platform.
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THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS.
CHANGES ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE CHANGES WILL BE
INCORPORATED IN NEW EDITIONS OF THIS DOCUMENT. TIBCO SOFTWARE INC. MAY MAKE
IMPROVEMENTS AND/OR CHANGES IN THE PRODUCT(S) AND/OR THE PROGRAM(S) DESCRIBED IN
THIS DOCUMENT AT ANY TIME.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE, INCLUDING BUT
NOT LIMITED TO ANY RELEASE NOTES AND "READ ME" FILES.

This and other products of TIBCO Software Inc. may be covered by registered patents. Please refer
to TIBCO's Virtual Patent Marking document (https://www.tibco.com/patents) for details.

Copyright © 1994-2022. TIBCO Software Inc. All Rights Reserved.
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